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Note: To avoid damage of your speakers, always turn down the volume, 
or turn off the power of your amplifier connected to the ST Audio DSP24 
ADAT when you are rebooting or shutting down your PC. 
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I. Introduction 
Congratulations on your purchase of the DSP24 ADAT by ST Audio. The DSP24 
ADAT is a PCI interface card to connect ADAT compatible hardware, such as 
multichannel recorders, digital mixers, synthesizers, etc. with your PC. With  
extensive experience in the audio and PC industry, combined with valuable 
suggestions from our customers, our engineers have developed a product we know 
you will be satisfied with. We guarantee you uncompromising quality, as well as 
excellent technical and audio properties at an extremely affordable price. 

What’s in the box ? 
You should have received the following with your DSP24 ADAT card: 

• ST Audio DSP24 ADAT PCI audiocard 
• Breakout cable (15pin D-SUB to RCA / TRS adapter) 
• 4pin-3pin cable for analog CD-ROM audio connection 
• 2pin cable for CD-ROM digital output 
• Driver and installation CD-ROM 
• Logic SoundTrack24 CD-ROM by Emagic 
• This manual 

Functions 
The DSP24 ADAT card from ST Audio is easy to install and contains everything 
you need to form a powerful 8 channel digital audio link between any of your 
ADAT compatible digital equipment, and your Windows PC. Simply insert the ST 
Audio DSP24 ADAT card into an available PCI slot, and connect it with optical 
cables to your ADAT compatible device. The available analog outputs allow you to 
monitor signals directly from the card without a separate DAC unit. 

Digital editing with the DSP24 ADAT card from ST Audio makes many jobs in the 
studio effortless. For example, using the card with a linear digital tape recorder you 
can send audio at up to 24-bit resolution into your computer, graphically edit your 
tracks in your favorite software application, before sending them back to tape for 
mixdown, archiving etc. Another great application is using your digital mixer as the 
AD/DA audio interface for all famous computer recording software applications. 
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II. Specifications 
• PCI 2.1 compliant interface 
• Optical ADAT interface: 8 input channels (up to 24-bit, 48kHz) 
• Optical ADAT interface: 8 output channels (up to 24-bit, 48kHz) 
• Coaxial S/PDIF I/O (24-bit) 
• Supported sample rates: 22.05, 32, 44.1 and 48kHz (plus 88.2 and 96kHz for 

S/PDIF) 
• Analog monitoring output (24-bit DA converter resolution), 1/4" connectors 
• Internal CD in plus Aux In via AC-97 Codec (Internal Mixer) 
• WordClock I/O (BNC) 
• MPU-401 compatible MIDI interface 
• Drivers for Windows 9x/Me, NT4, Windows 2000 and Windows XP 

available 
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III. In- and output connectors 
PCI card connectors / options 

 

1. optical ADAT input 
2. optical ADAT output 
3. connects to the breakout cable (15pin D-SUB to RCA / TRS adapter) – 

check the next page 
4. BNC WordClock input 
5. BNC WordClock output 
6. analog CD input (routed to Internal Mixer) – CON1 
7. analog Aux input (routed to Internal Mixer) – CON2 
8. Jumper settings for further configuration (see USING THE WORDCLOCK 

IN-/OUTPUT in the next section) 
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Breakout cable 

 

A. 15pin D-SUB connector that connects to the DSP24 ADAT PCI-card 
B. analog monitoring outputs (1/4" TRS unbalanced –10dBv, left and right 

channels), this output sends out the same signal as channel 1,2 of the optical 
ADAT-output 

C. coaxial S/PDIF in- and output (RCA) 
D. MIDI in- and output (DIN) 
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IV. Hardware installation 
Make sure the computer is switched off and unplugged. Remove the external 
computer cover. Insert the ST Audio DSP24 ADAT PCI-card into a free PCI slot 
making sure that it is pressed firmly into position and secure it to the computer 
case. Avoid using the first PCI slot (next to AGP) due to IRQ conflicts that can 
arrise with AGP graphics cards. 

You can use an analog cable to / from the CD-ROM drive if you want to listen to 
audio CDs via the analog monitoring output of the card. 

Now install the computer cover again, and connect the included breakout cable to 
the 15pin D-SUB connector on the bracket of the PCI-card. 

Using the ADAT I/O ports 
The next step is to connect your ADAT device(s) to the optical I/O connectors on 
the DSP24 ADAT card. We strongly recommend the use of only high quality 
optical leads to connect ADAT devices. Connect the ADAT output of the card with 
the ADAT input of your external ADAT compatible device. Connect the ADAT 
input of the card with the ADAT output of your external device. The DSP24 ADAT 
connects to any other device using the optical ADAT format. 

Using the WordClock in-/output 
When used in a professional studio envrionment that is using WordClock 
synchronisation, the DSP24 ADAT can send out WordClock sync signals and also 
use/recieve the clock from other WordClock devices. 

To use the WordClock output, connect the corresponding cable to the WordClock 
output BNC connector. It will always send out the sample rate that is selected by 
the software using the DSP24 ADAT. 

In order to sync the card to other WordClock devices, you need 
to configure the DSP24 ADAT by changing a jumper on the 
hardware itself. 

The picture on the right side shows the jumper block in it's 
default and recommended setup. All jumpers on HD5 to HD2 
are set to OFF. 

If you are not using the WordClock input, do not change these 
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settings! 

The settings shown on the left side enable the WordClock 
input. The HD5 jumper is now set to ON. The other jumpers 
(HD4, HD3 and HD2) are untouched. 

To sync the DSP24 ADAT card to an external WordClock 
source, External Links must be set to ADAT synchronisation. 
Check the CLOCK SOURCE SLECTION section in the EXTERNAL 
LINKS chapter later in this documentation. 
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V. Driver and software installation 
The DSP24 ADAT comes with a CD-ROM that contains drivers for Windows 
9x/Me, and WDM drivers for Windows 2000/XP. You can also download the latest 
drivers from our website at www.STAUDIO.com. Please note that the installation 
process is different, depending on the version of Windows you are using. 

Installation under Windows 9x/Me 
The following instructions refer to Windows 98 / 98 SE. The installation under 
Windows 95 and Windows Me is very similar, although the displayed dialog boxes 
might look slightly different. 

After installation of the DSP24 ADAT in a PCI slot in the computer, boot up the 
system. Windows will detect the new hardware automatically and display the 
following screen. 

 

Click Next. 
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Select Search for the best driver for your device and click Next. 

 

D:\sound\adat 

 

Check Specify a location. Do not check CD-ROM drive or Floppy disk drives. Type 
in <drivename>:\sound\adat (where <drivename> equals the letter of your 
CD-ROM drive) in the window displayed above and click Next. Alternativly, you 
can click Browse and select the correct directory on the CD, then click Next. 

Note: you cannot use the driver from the directory \sound\dsp24 or from 
\sound\dsp24ve, even if Windows might offer these directories. Make sure you are 
using the correct directory! 
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After Windows finds the driver you should see the above screen naming the driver 
information file indicated in the screenshot. Click Next. 

 

At this window, complete the installation by clicking Finish. Windows will now 
install the driver for you through a series of installation screens. If you are 
prompted to do anything (this would be unusual), please follow the directions on 
screen. 

The External Links software will be loaded automatically now. Check the next 
chapter for reference. 
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After the driver is installed ensure the installation worked by selecting Start > 
Settings > Control Panel > System > Device Manager > Sound, video and game 
controllers. You should see the audiocard's device listed there. Highlight it and 
click on Properties. You should see the message This device is working properly. 
Click on the Resources tab, you should see the message No conflicts. If so, 
congratulations are in order. You have successfully installed the drivers for the 
DSP24 ADAT under Windows 9x/Me. 

 



ST AUDIO DSP24 ADAT 

- 13 - 

Installation under Windows 2000 
The following instructions refer to Windows 2000. Please note that you must be 
logged in as Administrator or with similar rights in order to install the DSP24 
ADAT driver under Windows 2000. 

After installation of the DSP24 ADAT in a PCI slot in the computer, boot up the 
system. Windows will detect the new hardware automatically a few seconds after 
you have entered your password and display the following screen. 

 

Click Next. 

 

Select Display a list of the known drivers for this device so that I can choose a 
specific driver (very important!) and click Next. 
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Select Sound, video and game controllers on the next dialog and again click Next. 

 

Select Have Disk.... 

 

D:\sound\adat\wdm 
 

Type in <drivename>:\sound\adat\wdm (where <drivename> equals the letter of 
your CD-ROM drive) in the window displayed above and click OK. Alternativly, 
you can click Browse and select the correct directory on the CD, then click OK. 
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On this dialog (displayed on the previous page), make sure to select ST Audio 
DSP24 ADAT WDM Audio System. Do not select any of the other entries (very 
important!). Click Next. If you get a dialog box about a missing driver signature, 
you can ignore it and just select Continue. 

 

The next dialog is displayed to confirm the correct selection. Click Next. The driver 
files are now copied to your system. 

At the next window, complete the installation by clicking Finish. On some systems 
you will be prompted to reboot the system. If that is the case on your PC, click Yes. 

After the driver is installed, ensure the installation worked by selecting Start > 
Settings > Control Panel > System > Hardware > Device Manager > Sound, video 
and game controllers. You should see the audiocard's device listed there. Highlight 
it and click on Properties. You should see the message This device is working 
properly. If so, congratulations are in order. You have successfully installed the 
drivers for the DSP24 ADAT under Windows 2000. 
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Installation under Windows XP 
The following instructions refer to Windows XP. If you use Windows XP 
Professional, you must be logged in as Administrator or with similar rights in order 
to install the DSP24 ADAT driver. 

After installation of the DSP24 ADAT in a PCI slot in the computer, boot up the 
system. Windows will detect the new hardware automatically a few seconds after 
you have entered your password and display the following screen. 

 

Select Install from a list or a specific location (Advanced) and click Next. 

 

D:\sound\adat\wdm 
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On this dialog (displayed on the previous page), select Search for the best driver in 
these locations and make sure Include this location in the search: is checked. Type 
in <drivename>:\sound\adat\wdm (where <drivename> equals the letter of your 
CD-ROM drive) in the text box below above and click Next. Alternativly, you can 
click Browse and select the correct directory on the CD, then click Next. 

If you get a dialog box about a missing driver signature, you can ignore it and just 
select Continue installation. 

The driver files are now copied to your system. Once the installation is completed, 
this dialog will be displayed: 

 

Click Finish. 

After the driver is installed ensure the installation worked by selecting Start > 
Control Panel > System > Hardware > Device Manager > Sound, video and game 
controllers (you might have to switch your Windows XP Control Panel to Classic 
View to get to the System applet directly). You should see the audiocard's device 
listed there. Highlight it and click on Properties. You should see the message This 
device is working properly. If so, congratulations are in order. You have 
successfully installed the drivers for the DSP24 ADAT under Windows XP. 
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VI. External Links 
External Links is the control center of the DSP24 ADAT card. It controls the 
monitoring of your PC based studio. Different studio envrionments (e.g. analog 
mixing desk vs. PC as digital mixer) require different monitoring setups. 
Sometimes you want to listen to the signal you are recording directly (hardware 
monitoring). Sometimes you want to listen to a modified version of the signal (e.g. 
processed by an effect processor) or you want to listen to a completly different 
audio track whilst recording. This means that you need to be able to define what 
exactly is played through each separate output channels of your audiocard. 
External Links allows you to do that, choose the way you like to work. 

What is displayed by External Links? 

 

The main screen of the software is divided into two main sections. The output 
channels of the card are displayed on the left side of the window. The digital output 
(S/PDIF Out), and also the 8 channels of the optical ADAT output are displayed 
under the ADAT headline. The first output channel pair (Output 1,2) is 
automatically used as analog monitoring output. The right section symbolizes the 
I/O interface on the DSP24 ADAT card. The connectors on the left side (white 
circles) are the available sources for the outputs.  
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The virtual cables for the outputs (which mainly control the monitoring) cannot be 
removed but replaced by other connections. These connections are displayed as 
straight lines between the white circles. The available output sources are: 

• S/PDIF In; the signal from the coaxial S/PDIF input of the 
card 

• Wave S/PDIF Out; the playback of the wave device 
ADSP24 S/PDIF Out (n) or channel 9/10 of the ASIO/GSIF 
driver 

• Input 1,2; the signal from channel 1/2 of the optical ADAT 
input 

• WaveOut 1,2; the playback of the wave device ADSP24 Ext. 
WaveOut 1/2 (n) or channel 1/2 of the ASIO/GSIF driver 

• Input 3,4; the signal from channel 3/4 of the optical ADAT input 
• WaveOut 3,4; the playback of the wave device ADSP24 Ext. WaveOut 3/4 (n) 

or channel 3/4 of the ASIO/GSIF driver 
• Input 5,6; the signal from channel 5/6 of the optical ADAT input 
• WaveOut 5,6; the playback of the wave device ADSP24 Ext. WaveOut 5/6 (n) 

or channel 5/6 of the ASIO/GSIF driver 
• Input 7,8; the signal from channel 7/8 of the optical ADAT input 
• WaveOut 7,8; the playback of the wave device ADSP24 Ext. WaveOut 7/8 (n) 

or channel 7/8 of the ASIO/GSIF driver 

All of these available signal sources can be connected to the outputs on the left side 
of the External Links window. 

Monitoring 
For each stereo channel pair it 
is possible to activate direct 
monitoring (without any 
latency). As in the example on these two pictures, you simply do it by connecting 
Input 1,2 to Output 1,2. This means that the signal from the ADAT input channel 
1/2 is sent directly to the output channel 1/2 without any latency / delay. The signal 
you play inside your application via channels ½, are not audible now of course! 

The second picture shows the 
alternative: if you connect 
WaveOut 1,2 with Output 1,2, 
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the playback from your audio application is audible via the first output channel pair 
of the ADAT output. The signal from the input is not audible at the same time, 
unless the audio application provides monitoring functions which will introduce a 
delay (latency) to your signal. 

External Mixer 

The limitation of these two options 
for monitoring (which is a 
limitation of many pro audiocards) 
is that you cannot hear the input 
and output signal at the same time. 
If you use an analog (or digital) 
mixer that is connected to both the 
inputs and the outputs of the DSP24 ADAT card, you can monitor via the mixer so 
that is no problem. The DSP24 hardware however has a built-in digital mixer so 
you do not really need an external mixing desk. This function is called External 
Mixer (easy to remember!) and as the input and playback signals, you can connect 
it to Output 1,2 as shown on the picture. 

If the External Mixer is connected to Output 1,2 (or alternativly to S/PDIF Out), all 
input and all playback signals are audible simultaneously via the first two channels 
of the ADAT output and the analog monitoring output (or alternativly via the 
coaxial S/PDIF output). When you open the External Mixer (just click on the 
Ext.Mixer button under the menu), you can set the volume for each playback and 
input channel independandly. This allows you to create your own mix completly 
digitally inside your PC without the need of external mixing equipment and without 
the need for special software from third parties. This final mix can even be digitally 
resampled using the ADSP24 (n) Digital Mixer MME wave device or channel 
11/12 of the ASIO 2.0 driver. Check the section EXTERNAL MIXER in the following 
chapter of this manual for reference. 

Clock source selection 
The three buttons in the upper left corner of 
External Links allow you to select the clock 
source for the DSP24 ADAT card: 

 Internal Select this (default) if the DSP24 ADAT should be the master clock 
source for all operations. All digital devices connected to the 
ADAT or S/PDIF output of the card need to work with external 
synchronisation in this case. 
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 ADAT Select this clock source when the device connected to the optical 
ADAT input should supply the clock / samplerate for the DSP24 
ADAT card. 

 S/PDIF Select this clock source when you want to record from the S/PDIF 
input with the clock supplied by the device connected to the coaxial 
digital input of the card. Please note that you cannot select S/PDIF 
as clock source and record from the ADAT input at the same time. 

Please note that it is very important that an active device is connected to the digital 
input (ADAT and/or S/PDIF) when the sync is set to external (ADAT and/or 
S/PDIF). It is not possible to record a clean signal from the digital input if you use 
internal synchronisation ... also it is not possible to playback and record clean 
signals (on any in- and output) if you use external synchronisation without anything 
connected to the digital input. In fact, on some systems it is not possible to record 
and playback at all with a wrong sync setting! It is important to use this setting very 
carefully. It can also be changed in the H/W Settings dialog. 
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VII. Mixer controls 

Internal Mixer 
Clicking on Call Internal Mixer in the File menu inside External Links will launch 
the Windows Mixer (SNDVOL32.EXE) to control the Internal Mixer section of the 
card. 

The Internal Mixer on the DSP24 ADAT represents basically an additional 
soundcard which has been 'added' to the audiocard functions. You can use this 
section to play Windows sounds, or the metronome from a sequencer. You can also  
use it for consumer applications such as games, or for internet phone usage. Since 
the Internal Mixer even supports DirectSound, you can use it also for some 
conventional software synthesizer applications. The Windows Mixer is used to 
control these functions. These functions are represented by an AC-97 codec chip 
that is on your DSP24 ADAT card. AC-97 has been defined as standard by Intel for 
consumer audio applications on modern PCs. The AC-97 codec ST Audio is using 
works with a 18bit ADC, a 18bit DAC and an analog mixer. The output of the 
Internal Mixer is audible via the analog monitoring output only. 

Note that you would never use the Internal Mixer for high quality recording or 
playback for music production. This means: if you have no need for consumer 
audio applications (as mentioned above) or if you are using a separate consumer 
soundcard in your PC for such applications, you would never use the Internal 
Mixer and you can stop reading this section now. The Internal Mixer is a nice 
addition to the main function set of the DSP24 ADAT card - not more, not less. 

The following channels are available: 

Master Controls the Master output volume of the Internal Mixer. This signal is 
sent out via the analog monitoring output. 

Wave Controls the Wave volume. The signal you play via the MME device 
ADSP24 Int. WaveOut (or ADSP24 Int. Audio Device) is controlled here. 
Signals from pro audio applications (using ASIO or GSIF for example) are 
not controlled by the Internal Mixer of course. By default this device is 
selected as output for Windows system sounds under Control Panel > 
Multimedia > Audio > Prefered playback device. 

CD In  Controls the volume of the internal analog CD input (3-pin). 
Aux Controls the volume of the internal analog Aux input (3-pin). 
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External Mixer 
With the External Mixer you can control all incoming and outgoing signals (20 
channels in total). Open it by clicking on Call External Mixer in the menu of 
External Links or by clicking the Ext. Mixer button. 

 

Note: The External Mixer will only change the audible signal for monitoring 
purposes. You can either output it  through channels 1/2 of the ADAT output and/or 
through the S/PDIF output (setup in External Links). When you are recording an 
input signal, the External Mixer does not change the signal level. This ensures that 
you are always recording with best possible audio quality without reduction of the 
dynamic range. All professional cards opperate in this way. 

Master 

Controls the output volume of the External Mixer. The signal controlled 
here will be played through channel 1/2 of the ADAT output and/or 
through the S/PDIF output. It is even possible to resample the output 
signal of the External Mixer internally using the device ADSP24 Digital 
Mixer (n) or channel 11/12 of the ASIO driver. 

You can control the the volume of the left and right channels 
independandly. Muting the signal is possible as well. 
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Wave (1/2 to 7/8) 

In the Wave section you can control the volume of the playback signal (for 
the devices ADSP24 Ext.(n) WaveOut x/x or the channels 1~8 of the ASIO 
and GSIF driver). 

Muting each channel is possible (M button). Also you can control the 
panning independant for the left and right channel of each stereo device. 

 
 
 

S/PDIF Out 

In the S/PDIF Out section you can control the volume of the signal of the 
device ADSP24 Ext. S/PDIF Out (n) or channel 9/10 of the ASIO and GSIF 
driver. 

Muting the left and right channels is possible independantly. 

 
 
 
 

S/PDIF In 

This section controls the signal from the digital S/PDIF input of the card. 

Muting the left and right channels is possible independantly. 
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Input (1/2 to 7/8) 

These sections are controlling the volume of the different input channels 
from the optical ADAT input. 

Muting the left and right channels is possible independantly.  

 
 
 
 

Presets 

The External Mixer allows you to save four presets for quick 
access. You can easily load them by clicking on the 1, 2, 3 or 
4 button. To save the current settings under the selected 
number, simply press Save. 
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VIII. Hardware settings 
The H/W Setting dialog of the DSP24 ADAT is used to control the basic driver 
settings of the audiocard. You call it via External Links (H/W Setting button or via 
the menu). The H/W Setting dialog is also used when you open the ASIO control 
panel from an ASIO compatible sequencer such as Emagic Logic Audio or 
Steinberg Cubase VST. 

 

The upper section displays the current version of the driver that is installed. Also 
you can see the current latency that has been selected for the ASIO 2.0 driver. 
Below that, you can see the resolution of the converters that are used in your 
hardware installation. This will be always 24-bit on the DSP24 ADAT as the DAC 
used for monitoring on the card works with 24-bit resolution.  

Clock Settings 

The Clock Settings tab, controls the samplerate of the card. 

Under Audio Data Handling you can determine if the card allows you to playback 
and record with a bit-depth that is higher than the converter resolution (displayed 
above). As the converter resolution on the DSP24 ADAT is 24-bit, it does not 
matter in most situations what is selected here. The default setting is Allow 
operation when data exceeds converter resolution. 
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The Clock And Sample Rates (Hertz) section allows you to select the source of the 
clock for the DSP24 card. You can select between Internal Master Clock and 
External Master Clock. Make sure to select External Master Clock only if you are 
recording or monitoring from the ADAT or S/PDIF input of the card. In that case, 
the device that is connected to the input will supply the clock for all operations you 
perform with the card. If you select Internal Master Clock (default), the clock 
generator on the card will generate the samplerate. You will have problems with 
noise and clicks in your audio signal if you have selected external clock without an 
active device (DAT, MD, digital mixer, etc.) on the digital input. Also you will 
have similar problems when you want to record a signal from the digital input with 
the card set to internal clock. 

The section of the H/W Settings dialog also shows the current sample rate of the 
card, which has been set by your application software. The samplerate selected here 
will be used for all functions of the card. This includes the digital output, so if you 
sync an external device (MD, DAT, digital mixer, etc.) to the DSP24 card, it will 
use the clock that is selected here. The Rate Locked option is used to force the card 
to a specific samplerate. It is disabled by default (which is also our recomendation) 
which automatically allows your application software access to all supported 
samplerates. When the option is enabled, your software will only work with the 
selected sample rate. This means that any application that attempts to use the driver 
at a different sample rate will show an error message. Reset Rate After Play should 
be selected when you want the sample rate to return to a specific setting after 
software has finished using the card for playback and/or recording. This is 
especially important if your external device that is connected to the digital output of 
the card, is synced to the DSP24 card. If you just use the analog outputs, the 
selected samplerate and the Reset Rate After Play option are not important when 
the card is not used by your software at the moment. 

Keep in mind that the ADAT protocol does not support higher sample rates than 
48kHz. This means that you can only select 88.2 and 96kHz when you are working 
with S/PDIF signals. 

Device Settings 

The Device Settings tab controls the 
options needed for playback and 
recording.  

Under Waveout Driver you can 
select the MME/ASIO buffer size 
(latency). The smaller the selected 
value is, the smaller the resulting 
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latency of the ASIO driver will be (and the other way round). You might notice the 
latency when you perform some action inside your ASIO application (e.g. you are 
using a VST instrument in Cubase VST): the result of your action will be audible 
with a certain delay - the latency. With the current drivers (v6.x for Windows 
9x/Me), the latency can be lowered to 5.5ms at 44.1kHz when the smallest value 
(256) is selected. The Windows 2000/XP drivers allow you to lower the latency to 
7.5ms at 44.1kHz. If you increase the samplerate, the latency will be automatically 
lower (e.g. 88.2kHz will give you exactly halve of the latency time as 44.1kHz with 
the same buffer size; keep in mind that ADAT supports 48kHz max.). 

You have to keep in mind that a smaller latency also increases the PC utilization, 
and might have some influence on the performance (very much depending on the 
PC configuration). A buffer size that is too small may result in clicks or drop outs in 
the audio signal. Larger buffers could prevent this. This buffer size should be set in 
the dialog box before you launch your music software. In some ASIO applications 
it is important to re-launch the software even if you have changed the buffer size 
via the ASIO control panel inside the application. We strongly recommend this for 
Logic SoundTrack24 and other versions of Logic Audio from Emagic for example 
but it is also recommended for all other ASIO applications. 

The WaveDriver setting under the MME/ASIO buffer allows you to change the 
latency of the MME driver in ms for Windows 2000/XP (this setting is not needed 
under Windows 9x/Me). 

The MME drivers of the DSP24 card automatically synchronize the beginning of 
recording and playback for all audio devices. For some software applications that 
are using several MME devices simultaneously, you should select Single and 
In-Sync under MultiTrack Wave Drivers to ensure that all channels will begin 
playback and/or recording at exactly the same time. Otherwise select Independent - 
this allows you to use the cards MME devices with more than one application at the 
same time. 

Multiclient Support (Device Mixing) 

The DeviceMixing (MME / ASIO 
/ GSIF) section allows you to 
assign individual stereo output 
pairs to a certain driver model to 
be able to use several different 
programs (e.g. GigaSampler- / 
Studio and a Audio- / MIDI- 
Sequencer like Logic Audio or 
Cubase VST) at the same time. 
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These functions are not available under Windows NT 4.0, 2000 and XP (as 
GigaSampler-/Studio did not fully support these operating systems when this 
manual was created). The settings will not be available in that case. 

Multiclient support is available for MME drivers (e.g. usually used by WaveLab, 
Sound Forge, Cool Edit, Cakewalk, ...), the ASIO driver (e.g. used by Logic, 
Cubase VST, Reaktor, ...) and the GSIF driver (used by GigaSampler and 
GigaStudio). This even allows you to use GSIF software that was designed to run 
separately on a system without other software parallel to other audio programs.  

The example on the picture (previous page) shows a setup where the output 
channels 1~4 and the S/PDIF output channels are assigned to the ASIO driver. 
Channels 5~8 are assigned to GSIF. This setup is done before you start 
GigaSampler/-Studio and your ASIO application. It is not possible to change 
DeviceMixing setttings after you have launched your audio application(s). 

The last column of the section displays the resulting channel numbers. In this 
example, the S/PDIF output channel (which is usually 9,10) has been assigned to 
channel 5,6 of the ASIO driver. Also, the channels 5~8 are assigned to channels 
1~4 of the GSIF driver. This assignment is needed, because the DSP24 driver 
simulates a normal audiocard interface in the different driver models for the 
applications. This prevents compatibility issues with certain audio applications. 

It is not recommended to change this setup often, as the different applications will 
also save the channel assignments internally. If you change the settings in the 
DeviceMixing section, it is wise to double-check the soundcard setup inside the 
audio apps you are using after that. These options have been invented because of 
the demand from the users to be able to use GigaSampler/Studio simultanously to 
famous Audio-/MIDI-Sequencer software. We strongly recommend to use at least 
v1.64 of GigaSampler or v2.2 of GigaStudio in order to use the multiclient support. 
The performance may not be as good when using earlier versions of the software. 
GigaStudio 2.2 and above will give you best performance. 
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IX. Usage with software applications 
For each application you are using with the DSP24 ADAT you have to follow some 
configuration steps. Basically, every stereo input or output channel of the card can 
be used like a normal soundcard using the corresponding devices. Normally every 
program will have a configuration function where you can select the devices. 

Available in- and output devices 
The available wave devices for playback and recording are ("n" will be substituted 
with the number of the installed DSP24 card, normally 1): 

• ADSP24 Int. WaveOut (n) – plays audio data through the Internal Mixer 
(which will be audible only on the analog output of the card). Please note that 
this driver only supports 16bit/48kHz as maximum resolution and samplerate. 
Please note: if you use the WDM driver (Windows 2000/XP), the name of 
this device is ADSP24 Int. Audio Device. 

• ADSP24 Ext.(n) WaveOut 1/2 – first stereo wave output device. Use this 
driver to play audio through channels 1/2 of the ADAT output. Please note: if 
you use the WDM driver (Windows 2000/XP), the name of this device is 
ADSP24 Ext. 1/2 Audio Device. 

• ADSP24 Ext.(n) WaveOut 3/4 – second stereo wave output device. Use this 
driver to play audio through channels 3/4 of the ADAT output. Please note: if 
you use the WDM driver (Windows 2000/XP), the name of this device is 
ADSP24 Ext. 3/4 Audio Device. 

• ADSP24 Ext.(n) WaveOut 5/6 – third stereo wave output device. Use this 
driver to play audio through channels 5/6 of the ADAT output. Please note: if 
you use the WDM driver (Windows 2000/XP), the name of this device is 
ADSP24 Ext. 5/6 Audio Device. 

• ADSP24 Ext.(n) WaveOut 7/8 – fourth stereo wave output device. Use this 
driver to play audio through channels 7/8 of the ADAT output. Please note: if 
you use the WDM driver (Windows 2000/XP), the name of this device is 
ADSP24 Ext. 7/8 Audio Device. 

• ADSP24 Ext. S/PDIF Out (n) – plays audio through the stereo S/PDIF digital 
output. Please note: if you use the WDM driver (Windows 2000/XP), the 
name of this device is ADSP24 Ext. SPDIF Device. 
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• ADSP24 Multiple PCM Out (n) – this is an interleaved driver for playback of 
several channels at the same time. Some older audio applications are using 
this driver to access multiple channels on soundcards. Please note: this device 
is not available (and not needed) under Windows 2000/XP. 

• ADSP24 Int. Record (n) – records the signal from Internal Mixer. Use this 
driver to record from the internal CD or Aux input on the card. Please note 
that this driver only supports 16bit/48kHz as maximum resolution and 
samplerate. Please note: if you use the WDM driver (Windows 2000/XP), the 
name of this device is ADSP24 Int. Audio Device. 

• ADSP24 Ext.(n) Input 1/2 – first stereo input driver to record input signals 
from your ADAT device (channels 1/2). Please note: if you use the WDM 
driver (Windows 2000/XP), the name of this device is ADSP24 Ext. 1/2 
Audio Device. 

• ADSP24 Ext.(n) Input 3/4 – second stereo input driver to record input signals 
from your ADAT device (channels 3/4). Please note: if you use the WDM 
driver (Windows 2000/XP), the name of this device is ADSP24 Ext. 3/4 
Audio Device. 

• ADSP24 Ext.(n) Input 5/6 – third stereo input driver to record input signals 
from your ADAT device (channels 5/6). Please note: if you use the WDM 
driver (Windows 2000/XP), the name of this device is ADSP24 Ext. 5/6 
Audio Device. 

• ADSP24 Ext.(n) Input 7/8 – fourth stereo input driver to record input signals 
from your ADAT device (channels 7/8). Please note: if you use the WDM 
driver (Windows 2000/XP), the name of this device is ADSP24 Ext. 7/8 
Audio Device. 

• ADSP24 S/PDIF In (n) – records signal from the S/PDIF input of the card. 
Please note: if you use the WDM driver (Windows 2000/XP), the name of 
this device is ADSP24 Ext. SPDIF Device. 

• ADSP24 Multiple PCM In (n) – this is an interleaved driver to record several 
channels at the same time. Some older audio applications will use this driver 
to access multiple channels on soundcards. Please note: this device is not 
available (and not needed) under Windows 2000/XP. 

• ADSP24 Digital Mixer (n) – with this driver you can record the output signal 
of the External Mixer. This can be used to record output signals from one 
application in another program for example. Please note: if you use the WDM 
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driver (Windows 2000/XP), the name of this device is ADSP24 Ext. Digital 
Mixer. 

Additionally, the card provides an ASIO 2.0 driver called ADSP24 ASIO. It allows 
access to all 10 input and 10 output channels (8 ADAT + 2 S/PDIF) in applications 
that support ASIO (like Cubase VST). ASIO allows applications to record and 
playback at a very low latency (down to 2ms). This means that it is possible to 
apply realtime effects with your systems CPU input or output signals. Also, you 
can use software synthesizers to output through ASIO. 

Please note that most applications will need special settings to ensure that the 
DSP24 ADAT is working properly. We are continuously testing the card with 
various popular applications. In the following sections we have provided examples 
of a few applications. Please take the time to review it to avoid problems later. 

Setting up Emagic Logic SoundTrack24 
Logic SoundTrack24 is a special version of the Logic Software from Emagic, 
designed to be used with the DSP24 series of audiocards. It can use the ASIO driver 
of the DSP24 ADAT for recording and playback. Logic SoundTrack24 only works 
under Windows 9x/Me. 

• call the H/W setting dialog inside External Links. 

 
• under Device Settings select the ASIO buffer size: we recommend using a 

value of about 1024 – depending on the system performance. 
• click on the ASIO button under Device Mixing. 
• make sure the option Rate Locked under Clock Settings is disabled 
• set the option MultiTrack Wave Drivers to Independent (under Clock 

Settings) 
• launch Logic SoundTrack24 and select the option Audio>Audio Hardware & 

Drivers. 
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• select Audio & Hardware Drivers and select ASIO ADSP 24 as ASIO device. 

If you want to work with 24-bit resolution, enable the option 20/24 Bit 
Recording. 

• exit Logic and launch it again to activate the settings. 
Please also refer to the documentation of Logic SoundTrack24. 

Setting up Steinberg Cubase VST/24 3.72 
Cubase VST 3.72 from Steinberg uses the ASIO specification to access recording 
hardware. Steinberg has defined ASIO and improved support for recording 
multiple channels at the same time. ASIO features reduced latency for playback of 
VST plugins and instruments. Please note, that other Steinberg programs (like 
Nuendo, Cubasis VST or Cubase VST 5.x) have a very similar setup when using 
the ASIO driver. To setup the DSP24 ADAT in Cubase VST, please follow these 
steps: 

• call the H/W setting dialog inside External Links. 

 
• Select the ASIO buffer size. On faster systems (Pentium III, Athlon) it is 

usually safe to use 512 as a small setting. On other systems you may try this 
setting but increase the buffer size later, depending on the performance. Also 
you can decrease the buffer size but please test if the performance is OK on 
your specific system. 
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• click on the ASIO button under Device Mixing. 
• Start Cubase VST and select the option Audio>System. 

 
• In the section Audio Performance, set Number of Channels to 16 

(recommended). 
• In the Monitoring section, select Global Disable (recommended). If you want 

to monitor signals in realtime and adding VST plugin effects at the same time, 
select Tape Type instead. 

• In the upper right corner under ASIO Device select ADSP24 ASIO. By 
clicking on ASIO Control Panel, you can also change the samples per buffer 
value. 

• Below that you can choose the Sample Rate. 
• If you want to use the DSP24’s realtime monitoring functions (without 

adding effects to the monitor signal), select ASIO Direct Monitoring 
To define which input and outputs to use in Cubase VST, first go to Audio>Inputs. 
A window will appear that allows you to activate or deactivate each input (stereo). 
You can assign these inputs to the channels in the VST Channel Mixer then (via 
Audio>Monitors). For the outputs, you need to open Audio>Master. In this 
window you can deactivate a stereo bus for each stereo output. These busses can be 
used internally in Cubase VST to route signals to the outputs. You can find more 



ST AUDIO DSP24 ADAT 

- 35 - 

information about this in the Cubase VST documentation. Also, the latest updates 
for Cubase VST can be downloaded from http://www.steinberg.de. 

Setting up Emagic Logic Audio Platinum 4.7 
The powerful Audio-/MIDI-Sequencer Logic Audio Platinum 4.7 (and higher) 
from Emagic also uses ASIO drivers. Follow these steps to setup the application for 
the DSP24 ADAT. 

• call the H/W setting dialog inside External Links. 

 
• select the ASIO buffer size: we recommend using a value of about 1024 – 

depending on the system performance. 
• click on the ASIO button under Device Mixing. 
• launch Logic Audio Platinum and select the option Audio>Audio Hardware 

& Drivers>Audio Driver 2. 



ST AUDIO DSP24 ADAT 

- 36 - 

  
• check the box ASIO and select ASIO ADSP24 as ASIO device. If you want to 

record with 24-bit resolution, check the box 20/24 Bit Recording 
• exit Logic Audio and launch it again to activate the changes. 
You can get the latest informations about Logic Audio Platinum at 
http://www.emagic.de. If you use previous 4.xx versions of Logic Audio, we 
recommend to get the free update to Version 4.7 at least. 

Setting up Cakewalk Pro Audio 9.x 
Cakewalk Pro Audio is a famous Audio-/MIDI-Sequencer and recordingsoftware. 
It uses the MME drivers of the DSP24 ADAT. We recommend to use it under 
Windows 9x/Me. If you use Windows 2000/XP, the newer Cakewalk SONAR 
might be a better choice. 

• launch Cakewalk and select Options>Audio. The DirectShow Audio dialog 
will be displayed. 
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• Click on Drivers. You will see a list of MME devices for Input and Output. 

Select the entries you want to use (check the section AVAILABLE IN- AND 
OUTPUT DEVICES earlier in this chapter for reference). Usually you should 
select at least ADSP24 Ext. (1) Input 1/2 and ADSP24 Ext. (1) WaveOut 1/2. 

• Go back to General and select Wave Profiler. Follow the directions on screen 
until you see the message Audio hardware has been successfully profiled. 

• Select ADSP24 Ext.(1) WaveOut 1,2 as Playback Timing Master and 
ADSP24 Ext. (1) Input 1,2 as Record Timing Master. If you are recording 
from the S/PDIF input, select ADSP24 S/PDIF In (1) instead. The option 
Audio Driver Bit Depth should be set to 24. 

• Select the sample rate and resolution you want to use under Default Settings 
for New Projects. 

• Mixing Latency: Basically, you can set Buffers in Playback Queue as 4. 
Settings less than 4 will result in lower latency but the system performance 
could be lower, resulting in possible drop-outs. Start with buffer sizes 
suggested by the Effective latency tests, usually around 100msec. When the 
latency needs to be under 100msec, click on the Advanced tab and enable the 
WavePipe(TM) Acceleration option. Please note that each system will have 
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different optimal settings. You should experiement with the settings to get the 
perfect setup for your system. 

• Under Device Profiles, enable the option Use Wave Out Position For Timing. 
You can get the latest updates and informations on Cakewalk on 
http://www.cakewalk.com. 

Setting up Nemesys GigaSampler 1.64 
GigaSampler from Nemesys is a powerful and very popular software sampler. The 
DSP24 ADAT provides a special GSIF-driver (GigaSampler-InterFace) that allows 
you to use the separate outputs of the card with GigaSampler. We do not 
recommend to use older versions than GigaSampler 1.64. Also, the performance 
using the newer GigaStudio 2.2 (and above) by Nemesys is much better. 

• call File>Hardware settings in External Links. 

 
• press on the GSIF button under Device Mixing – or select GSIF for at least 

one channel. 
• launch GigaSampler and select Config>Outputs. 
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• Under Wave Out Driver, select Audio DSP24 MultiChannel Driver. 
• Select the Output channels you want to use on the right side under Outputs 

Enabled. 
• Now assign the Midi Channels mapped to Outputs in the lower area. 

You can get the latest informations and updates of GigaSampler on their website 
http://www.nemesysmusic.com. 
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X. Troubleshooting / FAQ 
This chapter addresses common questions to solve possible problems and avoid 
conflict with other PC hardware or specific system configurations. 

Q: Can I use the card with an AMD Athlon / Duron / Thunderbird CPU? Will it work 
with a VIA Cyrix CPU? 
A: Yes, of course! There are no compatibility issues with microprocessors. Please also check 
the following question about VIA chipsets, as many mainboards for AMD and VIA CPUs are 
based on VIA chipsets. 

Q: What about VIA chipsets? Can I use my VIA chipset based mainboard with the card? 
A: Yes, you can use VIA based systems with the DSP24 series of cards. Unlike with some other 
chipsets, the configuration in this case is more 'sensitive' and the system needs to be properly 
configured to avoid possible trouble: 
Please make sure the DSP24 PCI card gets a unique and unshared IRQ. Secondly, a recent 
version of the VIA 4-in-1 driver (we recommend at least v4.31) and the VIA USB Filter driver 
must be installed (check http://www.via.com.tw/ or the website of your mainboard 
manufacturer). If you are using Windows 98SE with USB enabled, Microsoft's UHCD Update 
should be used as well (do a search for 'uhcd.sys' on Microsoft's Knowledge Base). 
Please check if there is an update for the BIOS of your mainboard ... if so, please download and 
use it. 
On mainboards with the KT133 and KT133A chipset, you must use high quality 133MHz 
memory modules only. Also check the correspsonding setting in your BIOS (it should be set to 
133MHz) and make sure the memory timing is not set to an incorrect (e.g. too low) value. 
Set PCI DELAY TRANSACTION in your BIOS to DISABLED. Then, set PCI DEVICE 
LATENCY TIMER to a value of 32 or lower. PCI MASTER READ CACHING should be set 
to DISABLED as well (could cause performance problems, but because of the VIA 
southbridge bug, this setting is required). 
Last but not least, we recommend to disable all power managment related functions. 

Check the service section on www.STAUDIO.com from time to time to get more updated info 
on this topic. 

Q: Is it possible to install this card in a system with onboard-sound or another 
soundcard? 
A: Usually yes. As long as the other soundchip does not use a Envy24 / ICE1712, there should 
be no problems. You should make sure that both devices do not share their IRQ. 

Q: How many available IRQs do I need to use the card? 
A: Exactly one. It should be unshared if possible, because the DSP24 is a busmaster device ... 
otherwise you might get performance problems. It does not matter which IRQ number has been 
assigned to the card. 
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Q: I have read that the card is full duplex, but I can't do simultaneous record and 
playback with Cakewalk! 
A: Simultaneous record and playback needs to be enabled in Cakewalk Pro Audio. In the 
software, go to Settings > Audio Options > Advanced and make sure Enable simultaneous 
record and playback is checked. 

Q: I am using Cubase VST 5.x and I'm going crazy: always when I change a setting inside 
External Links or the mixer, the playback suddenly stops! 
A: Make sure the menu entry Options > Active in Background is checked inside Cubase. This is 
a general Cubase setting and not related to the audiocards driver. 

Q: I am using Cubase VST 3.xx and I'm going crazy: always when I change a setting 
inside External Links or the mixer, the playback suddenly stops! 
A: Goto File > Preferences and make sure that Active in Background is checked for MIDI and 
Audio. This is a general Cubase setting and not related to the audiocards driver. 

Q: I am using Cubase VST 5.x and it crashes as soon as I select the ASIO driver under 
Windows 2000 / XP. 

A: Launch SetupMME (inside the Steinberg folder of your Start-menu) and disable Microsoft 
GS Wavetable Synth as MIDI device. We also recommend to set ADSP24 Int. Audio Device as 
prefered playback device in Control Panel > Sounds & Multimedia > Audio. 

Q: I am using Nuendo under Windows 2000 / XP and it crashes as soon as I select the 
ASIO driver. 

A: Please set ADSP24 Int. Audio Device as prefered playback device under Control Panel > 
Sounds & Multimedia > Audio. Then reboot the system and launch Nuendo again. 

Q: When recording or playing audio, I get an audible click about every 3 to 5 seconds. Is 
the hardware defective? 
A: No! First of all, check the following two settings: 
Make sure the 'auto-play' function for CD-ROMs is disabled. Goto Control Panel > System > 
Device Manager > CD-ROM and select Properties for all CD-ROM drives. Now disable Auto 
Insert Notification under Settings. 
DMA access for your IDE HDDs must be enabled. Goto Control Panel > System > Device 
Manager > Disk Drives and select Properties for each IDE-HDD you have installed (an entry 
is typically called GENERIC IDE DISK TYPExx). Now enable DMA under Settings. 
Please check these settings from time to time. Some Windows installations 'loose' the DMA 
and CD-ROM notification settings when you are changing certain elements in the hardware 
configuration or if you boot Windows in Safe Mode. 

Q: I can hear cracks and noise when I play my recorded audio signal! Is this a hardware 
problem? 
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A: In most cases this problem can be solved by changing the interrupt which has been assigned 
to your hardware. Check in Control Panel > System > Device Manager > Computer > 
Properties if there is another hardware component using the same interrupt as the DSP24 
PCI-card (it should have its own interrupt, especially on mainboards using the VIA chipset). 
Except an IRQ-Holder (IRQ steering) entry, no other device should be listed with the same IRQ 
number. If you find such a problem, you usually have to install the DSP24 PCI card into a 
different PCI slot. On some mainboards you can change the IRQ assignment inside the BIOS of 
your mainboard. 

Q: I can hear noise when I move a window or fader on screen inside my audio 
application. I am using an ATI Rage 128 graphic card. 
A: Please download and install current drivers for your graphic card and set the bit-depth to 
32bit (not lower). This will reduce the system load the graphic card is causing. 

Q: I can hear noise when I move a window or fader on screen inside my audio 
application. I am using an Matrox Millenium/Mystique/G200 card. 
A: Please download and install current drivers for your grpahic card. Inside the Matrox specific 
options you can find a setting called Busmastering - please disable it. 

Q: Can I use Logic SoundTrack24 under Windows XP? 
A: No, this is not possible. All Logic 4.x versions from Emagic do only work under Windows 
9x/Me ... Windows 98 SE is recommended.  

Q: I am not able to change the MME / ASIO / GSIF settings for the multiclient driver in 
the Hardware Settings dialog. 
A: Under Windows NT 4.0 and Windows 2000/XP, these settings are not available as there is 
no multiclient support for GigaSampler-/Studio on this operating system. GigaSampler/-Studio 
currently do not work fully under Windows NT 4.0 or Windows 2000/XP (that is not related to 
our driver, that was a general limitation when this manual was created). 

Q: Why do I get error messages that the ASIO Multimedia test/configuration failed using 
Cubase VST, Cubasis VST or Nuendo from Steinberg? 
A: This test is done by the ASIO Multimedia driver from Steinberg that simulates ASIO for 
soundcards without ASIO support. It would disappear as soon as this driver is configured 
properly. However, as the DSP24 series of cards have their own ASIO driver for Windows 
9x/Me/2000, you don't need to run this test at all. Just select the ASIO driver (ASIO ADSP24) 
and then the ASIO Multimedia driver will no longer be used. 
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XI. Support / Contact 
ST Audio offers various resources to provide customer support. Please visit our 
website www.STAUDIO.com to access our customer service area. 

The extensive Knowledge Base and FAQ sections of our website, deal with 
common issues and are updated frequently by us. Please check this resource from 
time to time to get the latest updates on your DSP24 card. 

The Q&A forum on the website provides help – please use it to discuss all issues 
related to our products. Our qualified support staff from all over the planet (and 
some from other planets) will help you to solve issues you may have. This ensures 
the fastest reply possible, as tech support staff in different counties/time zones visit 
the site daily. Do not hesitate to use the Q&A forum for any question you might 
have or even positive feedback/suggestions. Other customers read the messages 
and will possibly reply to the requests on this forum as well. 

You can find updated versions of drivers, applications and documentation on our 
webserver. 


